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File menu commands

The File menu offers the following commands:

Enable Enable or disable WrapUp.
Modules Displays a list of module names for alternative Program Manager programs.
Exit Exit WrapUp.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Test menu commands

The Test menu offers the following commands:

Shut & Spawn Simulate the exiting of Windows and see WrapUp in action.
Restart 
Windows

Restart Windows.

Exit Windows Exit Windows and return to DOS.

Shut & Spawn (Test menu)

This menu choice will show you what WrapUp will do when Windows is exiting (without actually exiting 
Windows). It is useful for perfecting your ShutDown groups program contents by running WrapUp until 
you are satisfied with it without having to exit and then re-enter Windows each time you run WrapUp.



Restart Windows (Test menu)

This menu choice will restart Windows. It is here for your convenience if you ever want to restart Windows
rather than having to exit Windows and rerun it from the DOS prompt.



Exit Windows (Test menu)

This menu choice will exit Windows and return to DOS. If WrapUp is active, WrapUp will be triggered by 
this action.



Product Support (Help menu)

WrapUp is NOT free. Unregistered evaluation versions may be freely shared. Registered, purchased 
versions may NOT be shared.

If you like this program, send $39 dollars plus $5 shipping and handling. Site licenses and quantity 
discounts are available upon request. Feel free to contact us for a complete description of all of TNT's 35 
programs in the collection.

Visit our Internet home page at:    http://ourworld.compuserve.com/homepages/NIFTY_TOOLS

Tessler's Nifty Tools (TNT)    Release 6.4
430 Canyon Woods Place Suite A

San Ramon, Ca. 94583
(510) 275-9353

E-mail:      71044.542@compuserve.com

More information on using this program may be found in the WrapUp.txt file...



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Contents Offers you an index to topics on which you can get help.
Search for Help on... Searches for a Help topic by typing or selecting a keyword.
Using Help Provides general instructions on using help.
Product Support Where to get technical and sales support.
About Displays the version number of this application.



Enable command (File menu, System menu, & Toolbar)

If you want WrapUp to detect when Windows tries to exit, and then execute all of the programs in your 
ShutDown group, you must have WrapUp enabled. When you execute WrapUp, it defaults to enabled.

If you decide that you dont want to execute your programs before exiting Windows, you can either 
terminate WrapUp, or disable it. If WrapUp is disabled and minimized, its icon will change to a flashing 
icon with an x through it to remind you that WrapUp is disabled.

Shortcuts
Mouse: Click this button to enable or disable WrapUp.

- or -

You may click the red light on the signal light to disable WrapUp or click the green light on
the signal light to enable WrapUp.



Modules command (File menu)

Non Windows Program Manager users (such as Norton DeskTop) must modify WrapUp's command line 
with the /Pxxxx option so that WrapUp can correctly access the contents of the shutdown group. In order 
to do this, you must issue this command to see a list of desktop programs and their module names. 
Identify the name of your program manger program and its module. This module must be entered on 
WrapUp's command line as a /P option. For example, Program Manager's module name is PROGMAN.

This command is also useful for determining the module name of a program that you want WrapUp to not 
terminate before it executes all of the programs in your ShutDown group.

See /x (Exclude) Command Line option    for more information.



Exit command (File menu)

Use this command to end your WrapUp session.    You can also use the Close command on the 
application Control menu. Please note that if you terminate WrapUp, it will not be able to detect when 
Windows is trying to exit and therefore can not execute any of the programs in your ShutDown group.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in WrapUp.    A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in WrapUp,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button. A check mark appears next to the menu item when the 
Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the WrapUp window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.



Contents command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using WrapUp and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of WrapUp.



Search for Help On... command (Help menu)

Use this command to search for help on a topic or keyword of your choosing.



Context Help command 

Use the Context Help command to obtain help on some portion of WrapUp.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the WrapUp window, such as another Toolbar button.    The Help topic will be shown for the
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the WrapUp window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the WrapUp window.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



/i (Invisible) Command Line option

By adding the /i to the end of WrapUp's command line, you will force WrapUp's minimized 
icon to be invisible. This is useful if you don't want to see its icon on your desktop because 
you might find it distracting. Without the /i option, WrapUp displays its standard icon when 
minimized. The /i option is often used when the program is automatically run as a minimized
application from within your StartUp group.

Under Program Manager', WrapUp's property box contains the description, command line, 
working directory, short-cut key, and run-minimized options for WrapUp.

A typical command line might be:      c:\WrapUp.exe    /xPRINTMAN    /i

This command with avoid shutting down Print Manager and will have an invisible icon when 
minimized.



/x (eXclude) Command Line option

By default, right before Windows exits, WrapUp will terminate all of the executing programs 
on your desktop. Then it will execute the programs in your ShutDown group.    If you would 
like to leave certain programs executing, either because they must be kept executing (like 
Windows' Print Manager), or they are poorly written and don't terminate properly under 
WrapUp's control, you can tell WrapUp to exclude this program from its termination 
process. To do this, you must append the module name of the program that you wish to 
leave running after a /x option on WrapUp's command line. There may be any number of /x
arguments on the command line.

For example, if you would like WrapUp to leave both Print Manager and Clock executing 
before it executes the programs in your ShutDown group, you would have a command line 
with the following /x arguments:

WrapUp.exe    /xPRINTMAN    /xCLOCK

The module name of each program that you want to leave running may be determined by 
executing the program that you are interest in leaving running (like Print Manager) and then 
running WrapUp and run the File Modules command. Look for the name of your program 
(Print Manager) and write down the module name. This module name (PRINTMAN) will 
appear after a /x argument (e.g. /xPRINTMAN).



Installation, operation and removal instructions

To install under Windows 95:

Copy the following files to any single area of your PC's disk:

WrapUp.exe
WrapUp.hlp
WrapUp32.dll

A typical destination might be:    C:\TNT\WRAPUP

Start Windows 95.

Open your 'StartUp' folder from the Start-Programs menu. If you don't have a StartUp folder, 
create one... Then create a new icon for WrapUp so that it will automatically execute 
whenever Windows 95 is executed. Don't run it yet...

Decide on the name for your new folder that WrapUp will access when Windows starts to 
exit. We recommend the name 'ShutDown'. If you want any name other than 'ShutDown', 
you must use the /g command line option. See /g (alternative Group name) command line 
option for more information.

Create your new shutdown folder. The folder must directly reside off of the Start-Programs 
folder/menu (for example, the same menu that the Accessories folder resides in). Do not 
create a folder directly on your Desktop. This wont work! You can, however, create a short-
cut on your Desktop that points to the Programs folder/menu.

Move or copy your favorite programs icons into your new shutdown folder.

To install under Windows NT or Windows 3.1:

Copy the following files to any single area of your PC's disk:

WrapUp.exe
WrapUp.hlp
WrapUp32.dll

A typical destination might be:    C:\TNT\WRAPUP

Start Windows in either 'Standard' or 'Enhanced' mode. WrapUp    can not run in 'Real' 
mode.

Open your 'StartUp' group. Create a new icon for WrapUp so that it will automatically 
execute whenever Windows is executed. Don't    run it yet...

Decide on the name for your new group that WrapUp will access when Windows starts to 
exit. We recommend the name 'ShutDown'. If you want any name other than 'ShutDown', 
you must use the /g command line option. See /g (alternative Group name) command line 
option for more information.

Create your new shutdown group.

Move or copy your favorite programss icons into your new shutdown group.



To operate under Windows 95:

Restart Windows 95.

Observe that WrapUp is running.

Shut down Windows 95 by selecting Start-Shut Down-Shut Down the computer?. WrapUp 
will then wake up, and ask you via a dialog box, if you want to close all of your currently 
running desktop programs, and then it will execute all of the programs in your shutdown 
group. Saying YES will do the above. Saying NO, will simply exit Windows 95. Saying 
CANCEL, will abort the exiting of Windows 95. You may override the default operation of 
WrapUp so that it won't present you with the above dialog box by appending a /N to the 
command line. In this mode, upon detecting Windows 95 starting to shutdown, WrapUp will 
automatically close your desktop programs and then execute all of your shutdown group 
programs.

When you are finally ready to exit Windows 95, shut down Windows. This time, WrapUp will 
not intervene (since it already executed your shutdown programs) and you will truly exit 
Windows 95.

To operate under Windows NT or Windows 3.1:

Restart Windows.

Observe that WrapUp is running.

Exit Windows. You will get the familiar Windows "Are you sure you want to close" dialog box. 
Say YES. WrapUp will then wake up, and ask you via a dialog box, if you want to close all of 
your currently running desktop programs, and then it will execute all of the programs in your
shutdown group. Saying YES will do the above. Saying NO, will simply exit Windows. Saying 
CANCEL, will abort the exiting of Windows. You may override the default operation of 
WrapUp so that it won't present you with the above dialog box by appending a /N to the 
command line. In this mode, upon detecting Windows starting to exit, WrapUp will 
automatically close your desktop programs and then execute all of your shutdown group 
programs.

When you are finally ready to exit Windows, exit Windows. This time, WrapUp will not 
intervene (since it already executed your shutdown programs) and you will truly exit 
Windows.

To uninstall:

Delete WrapUp.exe WrapUp.hlp, and WrapUp32.dll from your disk.



Theory of Operation

Upon detecting Windows starting to exit, WrapUp closes all of your desktop programs so 
that after it then executes the programs in our shutdown group, it will be easy to determine 
which programs 
you need to deal with. They're the only programs left executing on our desktop.

When you try to exit Windows, you'll get the familiar Windows "Are you sure you want to 
close" dialog box. Say YES. WrapUp will then wake up, and ask you via a dialog box, (or it 
won't ask you if you've run WrapUp with the /N command line option) if you want to close 
all of your currently running desktop programs, and then it will execute all of the programs 
in your shutdown group. Saying YES will do the above. Saying NO, will simply exit Windows. 
Saying CANCEL, will abort the exiting of Windows. After you have interacted with the 
programs from your ShutDown group that are now executing, and when you are finally ready
to exit Windows, exit Windows. This time, WrapUp will not intervene (since it already 
executed your shutdown programs) and you will truly exit Windows.

LAN administrators can easily manage WrapUp by simply insuring that he proper shutdown 
group (GRP) file is present for proper operation. If the user is already running Windows in a 
LAN environment, then the proper group files are already present and no extra effort will be 
required. Please remember that one copy of WrapUp must be purchased for each and every
user of WrapUp.

You can control the execution order of both your StartUp and ShutDown group's programs by
modifying their GRP files. TNT's Grp2Ini program can make it easy for you to do this.

WrapUp memorizes the contents of your shutdown group when you first run WrapUp. If 
you modify your shutdown group's contents while WrapUp is running, then WrapUp will not
detect these changes. In this case, you'll need to terminate WrapUp and then re-execute it 
so that it will re-examine the new contents of your shutdown group. This WrapUp behavior 
is due to limitations in Windows.



/g (alternative Group name) command line option

If you want any name other than 'ShutDown' for your ShutDown group, you must use the /g 
command line option and so must tell WrapUp the name of your group by appending to 
WrapUp's command line, (open WrapUp's Program Properties dialog box by pressing Alt-
Enter when WrapUp's icon is highlighted) the name of the shutdown group after the /g 
option. For example, if you want your shutdown group to be called "My Shut Group", 
WrapUp's command line would be:

WrapUp.exe    /g"My Shut Group"

The quotes are only required when there are spaces in your group name. The group name is 
not case sensitive.



/p (alternative Program Manager) command line option

Non Windows Program Manager users (such as Norton DeskTop, PCTools MultiDesk DeskTop, 
and Windows NT) must modify WrapUp's command line with the /Pxxxx option so that 
WrapUp can correctly access the contents of the shutdown group. In order to do this, you 
must issue a WrapUp File Modules command    pull-down menu command to see a list of 
desktop programs and their module names. Identify the name of your program manger 
program and its module. This module must be entered on WrapUp's command line as a /P 
option. For example, Windows 3.1's Program Manager's module name is 'PROGMAN'. 
Windows 95's Explorer's (Program Manager's) module name is 'Explorer'. Below is a list of 
known alternative program managers and their associated /P option.

Windows NT: /PWOWEXEC
PCTools MultiDesk: /PWNDTLIB
HP DashBoard /PDASH



/n (don't ask to shut programs -just do it!) command line option

When you try to exit Windows, you'll get the familiar Windows "Are you sure you want to 
close" dialog box. After you say YES, WrapUp will then wake up, and ask you via a dialog 
box if you want to close all of your currently running desktop programs, and then it will 
execute all of the programs in your shutdown group. If you want WrapUp to automatically 
close all of your running desktop programs, append a /N option to your command line.

For example:      WrapUp.exe    /n



/s (don't shut programs before spawning) command line option

Normally WrapUp upon detecting that the user has told Windows to terminate, will 
terminate all currently running desktop programs before it executes any programs in the 
ShutDown group. You may use the /S option to tell WrapUp to not terminate the desktop 
programs. It will then only execute the ShutDown group's programs.

For example:      WrapUp.exe    /s



Supported Windows operating systems

WrapUp is completely and automatically compatible with Windows 95, NT, 3.1 and Windows
for Work Groups.



/m (Monitor ShutDown programs for termination) command line option

By including either the /Me or the /Mr command line option, upon executing each of your 
ShutDown group programs, WrapUp will monitor these applications for termination. Once 
they have all terminated, WrapUp will exit Windows (if you used the /Me option) or restart 
Windows (if you used the /Mr option).

These monitoring options are useful for users that have a program in their ShutDown group 
that automatically performs a function and then terminates. An example would be a 
program that logs the user off of his/her network and then terminates, or performs a backup 
of the users data and then terminates. Then WrapUp would detect the termination of all of 
the ShutDown applications (in this case a single application) and then it would exit or restart
Windows.

For example, to exit Windows when all ShutDown applications have terminated:
WrapUp.exe    /Me

For example, to restart Windows when all ShutDown applications have terminated:
WrapUp.exe    /Mr

 




